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Electron diffraction Complete procedure from data reduction to 
structure refinement using the dynamical 
approach. 

beginner 

Input data 

Data 

Electron diffraction data was measured on a transmission electron microscope Philips CM120 
with a precession device DigiStar. Accelerating voltage 120 kV. 

Input files  

directory “dp” with the set of experimental data (difraction patterns) 
Ni2Si.pts: input file for PETS2.0 
Ni2Si_reference.cif_pets: result of the data processing. This file is provided so that this example 
can be solved without the data processing part, and to warrant reproducibility of the solution 
and refinement part. File Ni2Si.cif_pets will be the output of the data reduction. 
Ni2Si_reference_dyn.cif_pets: result of the data processing for dynamical refinement. This file 
is provided so that the dynamical approach can be used without the processing part, and to 
warrant the reproducibility of the refinement. 
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Instructions 

PART 1 - Data treatment in PETS2.0 

1. Prepare (check) input file for PETS2.0 

File Ni2Si.pts is the input for PETS2.0. The file was prepared by the software used for the data 
collection. However, you can prepare easily such input file for your own data.  
Open file Ni2Si.pts in any plain-text editor (Notepad, Wordpad, Notepad++, Vim, … )  
The beginning of the file gives you the experimental conditions as comments (#). These are 
irrelevant to PETS2.0. The important part starts here: 
 

lambda 0.0335  

Aperpixel 0.002210  

phi 1.67  

omega 12.50  

pixelsize 0.01  

noiseparameters 3.5 38  

reflectionsize ??  

bin 2 

  

imagelist 

dp\001.tif -25.00   0.00 

dp\002.tif -24.00   0.00 

dp\003.tif -23.00   0.00 

... 

Endimagelist 

 

lambda: relativistic wavelength of the incident electrons in Angstroms (100 kV = 0.0370 Å, 120 
kV = 0.0335 Å, 200 kV = 0.0251 Å, 300 kV = 0.0197 Å) 

Aperpixel: Scale of the images given as the size of one pixel in reciprocal angstroms 
phi: Precession angle in degrees used during the data collection. Can be zero, of course. 
omega: orientation of the tilt axis of the sample holder with respect to the positive horizontal 

axis of the image. Must be estimated either by calibration, or by visual inspection of the series 
of images. Should be close to the correct value within +/-20 deg. Can be refined later in 
PETS2.0. 

bin: Binning of the images prior to any treatment. Saves time, makes nicer pictures, and seems 
to make the whole analysis somewhat more robust. bin 2 is a good choice from our 
experience for most data sets. Important: All parameters in the input file that are given in 
pixels refer to the original, unbinned images. This concerns Aperpixel, center, reflectionsize, 
mask. 

reflectionsize: Diameter of the spots on the images in pixels. Used for peak search and 
integration, should be large enough to encompass also the strong spots, but small enough to 
avoid overlaps of neighboring spots.  

noiseparameters: two parameters for the determination of σ(I). The first value is Gγ, the second 
is ψ. The uncertainty on each pixel γ is then calculated as: 
σ2(p)=Gγp+ψ 
For more information see Waterman, D. & Evans, G. (2010). J. Appl. Cryst. 43, 1356-1371. 

imagelist – endimagelist: Multiline keyword. Each line contains one image. The format is: 
name, alpha, beta. Name is the file name of the image (including possible relative or absolute 
path), alpha is the tilt angle, and beta is the possible second tilt value of the double tilt holder.  

Reconstruction – endreconstruction:  Multiline keyword to generate reciprocal space sections. 
Each line contains a specification of one layer in the reciprocal space that should be 



reconstructed by PETS2.0. The format is: filename, base vector 1, base vector 2, origin vector, 
where each vector is given by three reciprocal-space coordinates. The first two vectors define 
the orientation of the plane, and the third vector defines the origin of the plane. The standard 
set is hk0, hk1, hk2, hk3, h0l, h1l, h2l, h3l, 0kl, 1kl, 2kl, 3kl. You can determine a specific set of 
sections later in the graphical interface or directly in the input file using the keywords 
“reconstruction” and “endreconstruction”.  

 
Save and close Ni2Si.pts 

2. Run PETS2.0 and repare files for indexation 

Start PETS2.0 by double clicking the executable 
Go to File->Open in the upper menu 
Open the file Ni2Si.pts 
In the Main panel (Image data tab) you can view individual diffraction frames of Ni2Si dataset 
stored in the directory “dp” using the arrows at the bottom of the panel. The contrast of the 
images can be adjusted by changing the value in the Cutoff-box (inside the red retangle on the 
picture). The parameters of the input files are visible in the console and in the menus of the tabs 
“Parameters” and “Peak search”. The arrows to the left of “Frame” (at the bottom controls of 
the Image data panel in the blue retangle) and the value next to it control the image that is 
shown. The radio buttons “raw” and “processed” show you the raw diffraction pattern as 
recorded and the processed frame (some background correction etc.), respectively. 

 

Data reduction steps are run by clicking the respective action button. The action options can be 
modified in the panel which opens after clicking the small arrow next to the action button. The 
“Parameters” action button (first in the list of action buttons) is gray because there is no 
associated action. Note that you can adapt the size of the different window components (e.g. 
make the plot window more narrow or wider) and decouple the action bar or the console from 
the main window.  



 

3. Peak search 

Click on the arrows (v) next to “Parameters” and “Peak search” to check the following options  
Parameters - reflection diameter 12.5 
In our input file .pts, we defined “reflectionsize 25” and “bin 2”, hence the binned reflection 
diameter is 12.5 pixel. The default parameters used for min d* of 0.05 Å-1 is OK. Here it means 
that any reflection/peak that is less than 0.05*Aperpixel pixel away from the center is ignored. 
beam stop No;  
in Peak search parameters - Always accept center checked, use Friedel pairs 
Click the action button “Peak search” to start the procedure. The progress of the Peak search 
can be followed in the Image data panel. 
In the main panel, diffraction images are sequentially displayed with circles at points found by 
PETS2.0 as significant peaks (above I/sigma specified in the Peak search parameters). Crosses 
appear in the if the peak’s Friedel pair was detected  
At the end, the deviation of the x- (red) and y-coordinates (green) of the estimated direct-beam 
position is displayed in the Main panel in pixels (tab Graph): 

 

In the console, for each frame the estimated position of the primary beam, the number of 
Friedel pairs and the number of significant peaks are given. The process ends with the following 
message in the console:  
 
Minimum, average and maximum position of the primary beam:  495.72  497.57  

499.59  |    504.81  506.26  499.59 

Finished reading 3403 peaks from the file Ni2Si.rpl. 



4. Rotation axis  

The next step after peak hunting is the refinement of the angle between the horizontal axis (x 
axis of the diffraction image) and the projection of the rotation axis. This angle depends on the 
experimental setup, and needs to be refined for each data set.  
Click the action button “Rotation axis” to start the procedure.  
Switch to the tab “Cylindric projection” in the main panel to see the progress of the refinement 
In the main panel “Cylindric projection”, a cylindrical projection of the difference space of the 
extracted peak positions is displayed. A correct azimuthal angle refinement results in the image 
containing sharp peaks aligned on sinusoidal curves. This step provides a first estimation of data 
quality. At the end of the refinement the omega angle is 12.9219 degree. 

 

5. Peak analysis 

Click the action button “Peak analysis”.  
PETS2.0 starts the analysis of the peak positions obtained in the peak hunting procedure. In the 
first step, distance distribution between peaks in the image plane is analyzed. A sorted plot of 
inter-peak distances is displayed in the Processing tab (red curve) with its derivative (green): 

  

Click “Peak analysis (continue)” 
For good quality data set, the red curve contains distinct steps, and, consequently, the green 
curve has distinct peaks. 
Click “Peak analysis (continue)” 
In the next step, an auto convolution of the diffraction pattern (difference space) is analyzed, 
and the groups of peaks in the auto convolution (clusters) are replaced by the cluster centers. 
Again, a distance distribution is displayed (right screenshot), and clear-cut steps on the curve 
indicate a well-defined lattice. 



Now the first step is finished and PETS2.0 prepared the files needed for unit cell indexing. 
At this end of this step, you should get the following message in the console: 
 
Thresholds for considering two peaks the same: 0.0084 reciprocal angstroms. 

 12844 peaks merged into 10314 clusters, 750 with more than one peak. 

Peak analysis successfully finished. 

6. Find unit cell and orientation matrix 

Click “Find unit cell and orientation matrix” 
New set of buttons with parameters opens as well as a new tab “3D panel” that displays the 
data used for indexing. The data can be enlarged by scrolling the wheel of your mouse, and 
rotated by holding the left mouse button. 
Select “Data used for indexing: xyz” for the indexing  

 

Open the menu below “Find possible cells automatically” by clicking on the arrow next to the 
action button.  
You can see the parameters used in the procedure as wells as the possible unit cells found later 
by PETS2.0. 
Check that the selected option is “from difference space” and keep the other parameters  
default.  
Run “Find possible cells automatically” 
Only one unit cell is found (see below) and the initial unit cell 10 10 10 90 90 90 is replaced by 
the new one a = 3.7569 Å, b = 5.0315 Å, c = 7.1091 Å, α = 90.089°, β = 90.119°, γ = 90.452°   
Make sure that you use the Ni2Si.xyz file in “Data used for indexing” for the refinement 
Click on the arrow next to “Refine cell” to access the options 
Keep the default “Refine UB + cell”, 
 Select “orthorhombic” in symmetry 
Click “Refine Cell” 
The refined unit cell parameters are a = 3.7484 Å, b = 5.0173 Å, c = 7.1075 Å, α, β, and γ angles 
were set to 90. 
You might already guess the space group checking the extinctions here. 
Select “Data used for indexing: cor” 



On the “Indexation display options”, select “View along an axis: a” 
Use “Rectangle area selection” to select the inner column in the “3D panel” 
 

  

 
On the “Indexation display options”, select “View along an axis: b” 
Enable “Show lattice”and use 2x2x2 
 

  

 
You will see that there are systematic extinctions h+l=2n+1 along h0l. If you reset the area 
selection and select the column corresponding to h1l, the absent reflections on h0l are present 
in h1l.This extinction condition corresponds to an n-glide plane perpendicular to the b-axis. If 
you reset the area selection and repeat the selection along the a-axis to see 0kl and 1kl, you will 
see that there are no further systematic absences. The space group symbol is Pmn-, which is 
non-standard Pnm- with our settings. The unit cell found by PETS2.0 might lead to a non-
standard setting because it arranges the cell parameters based on the length. We will go back 
to the indexing and change the setting so we can have the standard one. 
 



Select “Data used for indexing: xyz” for the indexing  
In “Modify cell”, use the “Transformation matrix” according to the image below: 

 

Click on the arrow next to “Refine cell” to access the options 
Keep the default “Refine UB + cell”, 
 Select “orthorhombic” in symmetry 
Click “Refine Cell” 
The refined unit cell parameters are a = 5.0173 Å, b = 3.7484 Å, c = 7.1075 Å, α, β, and γ angles 
are 90. 
Leave the indexing panel by clicking “Finish”  

7. Create reciprocal-space sections 

PETS2.0 scans all images and reconstructs sections through reciprocal space at planes hk0, hk1, 
hk2, h0l, h1l, h2l, 0kl, 1kl, 2kl (default set). These sections are used as an aid to determine the 
space group. Sections are saved in the directory sections as TIF-files. In the parameters of the 
Reciprocal-space sections, you can change the size of pixels in the reconstruction images and 
the thickness of the slab that is projected into the section in Å-1. Too small numbers may result in 
“holey” reconstructions. We will proceed with the default values. 
Click “Reciprocal-space sections”, OK (use the standard set)  
You can visualize the sections in the tab “Section images” of the main panel and choose the 
section as shown on the picture below. 



 

From electron diffraction, it is often difficult to select the correct space group. In particular, 
presence or absence of the glides and screw axes is hard to asses, knowing that kinematically 
absent reflections may have significant intensities due to dynamical diffraction effect. In this 
case the missing wedge leaves almost no information in the hk0 reciprocal-space section (see 
section hk0), and we cannot estimate the presence of absence of a glide plane in this direction. 
In the other directions the reconstructed reciprocal space sections can be very helpful in 
estimating the symmetry. In Section 6 (Find unit cell and orientation matrix), we found that the 
diffraction symbol is Pnm-, in the standard setting, and this can be confirmed in the reciprocal 
space sections. This corresponds to the space group Pnmm, Pnma, or their non-
centrosymmetric subgroups. 

8. Integrate  intensities  

(a) Process frames for integration  

Start the procedure by clicking the action button “Process frames for integration” with all 
parameters of this section set by default: the box “shift integration box maximum intensity” is 
selected and the parameters RC width and mosaicity stay at their default values. 
 

 

 

In the Image data tab, diffraction frames with circles drawn at positions predicted from the 
orientation matrix are displayed. A green circle means that a peak with I>3𝜎(I) was found. A 
brown diamond means that a reflection is expected on upcoming frame(s) or was present on 



previous frame(s). To access the resolution of you data, you can also display the resolution rings 
by selecting the option “rr” in the Image data panel (see below).  
 

  

 

At the end of the integration process, in the Graph tab, the camel plots (rocking curves profiles) 
are displayed (data - blue, fit - red). On the horizontal axis of the plot there is the excitation 
error of reflections. Each curve shows an average rocking curve of reflections in one resolution 
shell, starting from 0.2-0.3 Å-1 in steps of 0.1 Å-1. Notice the splitting of the humps with 
increasing diffraction angle due to precession. By changing the parameters you can observe 
their effect on the curve. The reflections considered for the visualization of the camel plots are 
affected by the I/σ(I) threshold.  
 

 



(b) Optimize geometry and integration parameters  

Go to the options of “Optimize geometry and integration parameters” 
Check that the refinement using rocking curve profile is checked as well as the RC width and 
mosaicity parameters.  
Start the fitting procedure by clicking on the action button.  
The fit results in the RC width of ~0.0018 Å-1and mosaicity ~0.294 deg. The fit is slightly 
improved as visible in the plot on the Graph tab:  

 

If the data or the fit would not seem to converge to the baseline at the x-limits on the graph it is 
necessary to rerun the previous step (Process frames for integration) with the newly refined 
parameters, otherwise it is possible to continue directly to next step. Here, we will run the 
Process frames for integration once more. 
Run “Process frames for integration” 
The resulting camel lot looks like this: 

  

(c) Finalize integration  

Open the parameters for “Finalize integration” 
Check that both “kinematical” and “dynamical” integration are checked 
Select the radio button “integrate profile” next to “intensity estimation”.  



Default value for intensity estimation is “integrate profile”, which is the more robust technique 
and works well even for poorer data. However, for good data the “fit profile” option gives better 
results. 
Run the procedure by clicking the action button.  
After the integration, PETS2.0 shows the table of Rint values in the console for the different Laue 
classes. For the Laue class mmm the Rint of observed reflections is 12.36 % for 115/154 
observed /all unique reflections. 
Select the radio button “fit profile” next to “intensity estimation”.  
Run the procedure by clicking the action button “Finalize integration”. 
The table of Rint values in the console for the different Laue classes shows Rint of observed 
reflections 10.78 % for 109/147 observed /all unique reflections for the Laue class mmm.  

 

Optionally, it is possible to include frame scaling which optimizes frame scales to reach the best 
Rint for the given Laue class. In our case, we use Laue symmetry mmm. 
 
Check the check box frame scaling, select Laue class mmm 
Write 2 for “Interframe correlation range:” 
Write 1 for “Interframe correlation weight:” 
Run the procedure again by clicking the action button “Finalize integration”. 
 
The frame scaling may take some time. Rint lowers from 10.78% to 8.47% for Laue class mmm. 
It is possible to view the scale factors for individual frames on the tab Graph: 



 

When the integration finishes, files Ni2Si.cif_pets and Ni2Si_dyn.cif_pets are created. 
Ni2Si.cif_pets is used to solve the structure and for kinematical refinement, while 
Ni2Si_dyn.cif_pets is used for dynamical refinement. 

PART 2 - Structure solution and kinematical refinement in Jana2020 

1. Create new structure  

Important! The data-processing procedure is almost never perfectly reproducible. Small 
differences in the indexing and cell refinement procedure may result in small differences of 
integrated intensities. If you want to be sure that you can reproduce the following part of the 
tutorial, do not use the file Ni2Si.cif_pets that you have just created, but use the file 
Ni2Si_reference.cif_pets provided with the example files. Using your own cif_pets file is also 
possible, but your results may slightly differ from the results described in this tutorial.  
 
Start Jana2020 

In the Main menu bar, use “Structure → New” and open new structure “Ni2Si” in the directory 
of the Example 13.5 

2. Import Wizard 

[On the screen: Specify type of the file to be imported] 
Select “Single crystal: known diffractometer formats”; NEXT 
[On the screen: Data reduction file from] 
Select “Pets electron diffractometer” 
For “Input file”, browse the file Ni2Si_reference.cif_pets (or your file) 
This file produced by PETS2.0 contains all important information, including the list of intensities. 
Check if “Make the reflection file for dynamical refinement” is disabled 
NEXT 
[On the screen: Complete/correct experimental parameters] 
Leave all settings unchanged; NEXT 
Leave all settings unchanged; NEXT 
The program reads 670 reflections from the file  
OK 
For absorption correction select “None or done before importing” (default); NEXT 
FINISH; OK to accept the data set  
You just read in the cell parameters and the intensity list. If you do not have the data in the 
cif_pets format, you can read them in from a general hkl file using the option “reflection file 



corrected for LP and absorption” at the beginning of the import wizard. You then have to input 
the radiation type, wavelength and cell parameters by hand. 

3. Symmetry Wizard 

NEXT to close the information window and start the symmetry wizard. 
Symmetry Wizard can be started separately by expanding “Reflection file” in the Command tree 
and selecting “Make space group test”. The default settings are prepared for x-ray diffraction. 
For electron diffraction we have to increase the tolerances.  
Change the tolerances according to this screenshot: 

 

NEXT 
 [On the screen: Select Laue point group] 

  

Select orthorhombic mmm; NEXT  
The internal R-values would be rather high for x-rays, but are low for electron diffraction data. 
[On the screen: Select cell centering]  
Select primitive unit cell; NEXT 
[On the screen: Select space group] 
The window shows possible space groups. 
The list of the strongest reflections contradicting the selected space group can be displayed by 
“Details” button. 
In Section 7 in Part 1 (Create reciprocal-space sections), we saw that the diffraction symbol is 
Pnm-, corresponding to the space group Pnmm or Pnma. We will choose Pnma simply because it 
is a very frequent space group. 
 



 

  

Important: Note that a wrong choice of the space group is not detrimental for the structure 
solution, because we will use Superflip, which will make additional check for the most probable 
space group. 
Select Pnma; NEXT 
Accept the space group transformed into the original cell; FINISH 
Symmetry is saved in file Ni2Si.m50. 

4. Creating refinement reflection file 

 In this step program creates file Ni2Si.m90 containing the data set merged by symmetry and 
with discarded forbidden reflections. Ni2Si.m90 will be used for refinement. 
Proceed with the wizard, leaving all settings default. NEXT 
The Import statistics-obs/all gives 479/670 reflections read from input file, 459/595 reflections 
written to output file and 20/75 reflections rejected as symmetrically extinct.  
OK,  
OK again; NEXT 
The Rint(obs/all) =  8.37/8.87 for 99/122 independent reflections. 
OK; FINISH  

5. Structure Solution Wizard 

OK to close the information window and start the solution wizard  
 [On the screen: window of Structure solution] 
 Structure solution wizard can be executed separately from the Command tree. Jana2020 does 
not contain solution procedures, it calls external programs. By default, Jana uses Superflip 
(using charge flipping as the solution method). Superflip is distributed with Jana2020. 
 

In “Formula” textbox type just the list of chemical elements: Ni Si 
Superflip does not need information about the chemical composition but it will be required for 
the peak assignment based on the electrostatic potential map calculated by Superflip. If 



Jana2020 is used for peak assignment, a list of expected chemical elements is sufficient. If you 
know the expected formula, you may enter it and use EDMA for peak search (at the bottom of 
the window). If the formula is correct, EDMA often gives cleaner and more complete 
interpretations of the solution. 
Check if CF (charge-flipping) is selected for the “iteration scheme”. 
Leave other settings default; “Run Superflip”. 

 

Window of Superflip appears with iteration running. After ten runs, a window with Superflip log 
file is displayed. The number will be close to the ones in the table below, but not identical, as 
Superlip starts each time from a different random starting point. 
 

 
 
The space group proposed by Superflip is the same as our initial guess. The space-group 
selection is confirmed.  
Click “Draw 3d map” 
VESTA opens with a 3d electrostatic potential shown as isosurfaces, and an atomic model 
overlaid (in the default settings the shown isosurface level corresponds to the 2σ level based on 
the statistics of the 3D electrostatic potential map). Rotate the view to inspect the structure. Do 
you think it is complete?  



You should come to the conclusion that the model is correct, correct elements were assigned to 
all maxima. 
Close VESTA (do not save the file) 
You may now check the structure to convince yourself that the structure is complete and 
chemically reasonable. 
Click “Draw structure” 
Now the structure is displayed using the plotting program of Jana2020 called JanaDraw 

In the lower toolbar, press Fill unit cell  
Close JanaDraw 
Press “Accept last solution”  
The program creates file Ni2Si.m40 with atoms of the structure model 
 

6. Kinematical refinement 

[On the screen: basic window of Jana]  

Right-click the quick button “Run Refinement”.  
[On the screen: refinement options] 
Change the number of cycles to 100; 
OK 
Choose “Yes+start” 
 
Refinement converges with Robs value about 12.47%. At this moment you may check the 
refinement listing with a lot of information about the refinement procedure and results. As you 
can see, the refinement is already very good for electron diffraction. R values are low, all the 
ADPs were positive. Refinement of anisotropic atomic displacements would further decrease the 
R-value (Robs=11.59%), but the ratio reflections per parameter is already low. 
 

The resulting structure 

In the Command tree, expand “Draw structure” and start “Vesta” 

    

 

PART 3 - Dynamical refinement in Jana2020 



1. Preparation of reflection file for the dynamical refinement 

During the integration procedure in PETS2.0, an input file for dynamical refinement was created. 
The integration for the dynamical refinement considers each diffraction image separately. The 
result is a list with the hkl indices, the measured intensity with the respective σ(I) and the 
number of the frame in which the intensity is present. PETS2.0 creates the file Ni2Si_dyn.cif_pets 
with all this information, which will be used in Jana2020. Note that the same hkl reflection 
might be present in several frames, with different intensity due to the multiple scattering 
relative to different crystal orientation and thickness at this condition. 
 
In the main menu bar, use “Structure → Save as” and save a new structure Ni2Si_dyn for the 
dynamical refinement 
YES to Continue with the new structure. 
This step saves the structure you refined kinematically as a new job, which will be used for 
dynamical refinement. 
 
In Command Tree, expand „Reflection file“ and start „Import-modify reflection file“ 
Click „Reimport“ 

Important! Here again, if you want to be sure that you can exactly reproduce the following part 
of the tutorial, use the file Ni2Si_start_dyn.cif_pets provided with the example files. Rename this 
file to Ni2Si_dyn.cif_pets. 
Select the Ni2Si_reference_dyn.cif_pets as the new reflection file 
Enable “Make the reflection file for dynamical refinement” 
NEXT, NEXT, NEXT. 
Now, Jana reads 4166 reflections from all the frames. 
OK, NEXT, FINISH, OK 
[On the screen: Processing refinement reflection file…] 
Check that “Make the reflection file for dynamical refinement” is enabled, NEXT 
Notice that 2334 reflections are observed out of 4166 reflections read. From these, 80 were 
rejected because they violate the systematic extinctions. You can find this information in the file 
*.rre (Edit/View→Reflection report). 
OK, OK, FINISH 
 [On the screen: basic window of Jana] 
In Commads Tree, expand “Edit structure parameters” and start “Edit parameters for electron 
diffraction” 
 [On the screen: Parameters for electron diffraction data] 
Check that “Use dynamic approach” is enabled 
 

2. Dynamical refinement parameters  

[On the screen: Parameters for electron diffraction data] 
The default values for the selection of the intensities are: g(max)=1.6, maximal excitation error 
Sg(matrix)=0.01, maximal excitation error Sg(refine)=0.1 and Rsg=0.4. These values are “safe” 
to produce good quality refinement, but they are not optimized for speed. You can set the 
number of threads to the number of cores on your processor to speed up the calculation. 



 

3. Sample thickness 

The sample thickness is an important parameter of the dynamical refinement. The default value 
is 400 Å. 
Enable “Except of scale, optimize also: Thickness” 
Click “Run optimizations” 
Dyngo calculates wR-factor for the thickness varying from 0 to 2000 Å. 
“Show thickness plots”. Check the variation of the thickness of the crystal for the frames. Quit. 
Most frames have well defined wR-factor minima for one thickness. However, few frames either 
have poorly defined minimum or the minimum is at a very different thickness. You can check the 
wR(all) going through the zones in the main window of “parameters for electron diffraction 
data” or while viewing the graphs.  



 
 
For example frames 13, 14, 25, 28, 33, 34 have the minimum at very low thickness (0 Å). Frames 
31 and 65 have a plateau for thickness between 0 and 400 Å. Notice also that the maximum R-
factor is around 55 % for the last frame. You can check the wR(all) going through the zones in 
the main window of “parameters for electron diffraction data” or while seeing the graphs. The 
different thickness is usually not a problem, but if you encounter a very aberrant frame (or a 
sequence of consecutive frames), it may be removed from the refinement by deselecting it in the 
list of zones for refinement. 

4. Defining all the zones with the same thickness 

 “Define zones of equal thickness”. “Select all”, OK 
The crystal is a nanowire and the thickness is mostly constant along the sample. However, the 
thickness changes according to the tilt of the sample, because the nanowire lies roughly 
perpendicular to the tilting axis of the sample holder. Then, it is possible to define the same 
thickness for all the frames but still refine the variations of the thickness according to the tilting 
of the sample. 
There are two ways of defining the same thickness for all the frames. You can either estimate an 
average thickness and type it for all frames, or run 0 refinement cycle and average the 
thickness. We will use the first option here, because it is faster and easier. 
Looking at the thickness plots we have seen that the thickness is most of the times very low. 
100Å seems to be a good estimate. 
Click “Select zones for editing”. 
Click “Select all” 
OK 

Click in the field EDThick  and then click the yellow button “Unlock”.  
Type 100 in the field EDThick 
Now we need to rerun the optimization of frame scales, as changing of the thickness also 
requires adapting the scale. 
Click “Run optimizations” 
In a few seconds the optimization is finished. 
Click OK and YES to return to the main screen of Jana2020. 
Right-click the quick button” Refine” 
On the tab “Basic” check that the number of refinement cycles is set to 100. 



OK; “Yes+Start”. 
The refinement runs 10 cycles, each cycle takes less than a minute (depending on your 
computer). You can see the details of the refinement in the file Ni2Si.ref (Command Tree → 
Refinement→ View refinement listing). The refinement converges with R=9.51%. However, the 
ratio reflections per parameter refined is around 8 (689/84) and it is advisable to increase it. It 
can be done by increasing RSg (selecting more reflections for the refinement). 
Another important thing to check is the number of observed reflections per zone. Also in the 
Ni2Si.ref file, you can see “R-factors for individual zones”, where the list of zones with the 
respective R-factors and number of reflections is shown. 
 

5. Optimization of orientation 

Save a new structure “Structure→Save as→ Ni2Si_dyn_ori”; OK; YES 
In Commads Tree, expand “Edit structure parameters” and start “Edit parameters for electron 
diffraction” 
 [On the screen: Parameters for electron diffraction data] 
Change the “Limit on RSg” to 0.75 
Enable “Except of scale, optimize also: Orientation” 
Click “Run optimizations” 
[On the screen: Intensity calculation for optimizing of orientation]. 
The orientation of the crystal during the measurement plays an important role in the dynamical 
scatterings. EDTheta is the amplitude of the correction of the frame orientation. It should be a 
small number, a few tenths of a degree at most. Typically, a deviation of 0.5° is already 
considered high. 
Using “Zone #” box, check the resulting EDTheta for the individual frames.  
The frames with high misorientation are: 1, 2, 3, 8, 9, 10, 17, 18, 19, 22, 24, 28, 33, 34, 36, 43, 
44, 52, 61, 63, 70, 72, 73, and 74. If you check these frames, most have few reflections (because 
the unit cell is small), the reflections are mostly weak (the nanowire is very thin) and some 
frames have 1 or 2 peaks visibly stronger than the rest. These stronger reflections dominate the 
optimization and hamper the correct estimative of orientation. Frames with EDTheta larger 
than 0.5° will be removed from the refinement. 
Note that such a high number of misoriented frames is unusual and happens only in this case of 
very weak data on a structure with a small unit cell. Typically, only a very small number of 
frames, sometimes none, need to be removed in this step. In the present case, an alternative 
approach is not to apply frame orientation at all. In this example, the orientation is applied 
nevertheless for demonstration purposes. 
 

“Select zones for refinement” 
Disable the frames 1, 2, 3, 8, 9, 10, 17, 18, 19, 22, 24, 28, 33, 34, 36, 43, 44, 52, 61, 63, 70, 72, 
73, and 74 (Ctrl + left mouse button). 



 

OK; OK; YES to save file M42 
Click the quick button” Refine” to start refinement. 
Start the refinement. 
 
The refinement converges with R=8.29% after 3 cycles. Since there are more reflections now, it is 
possible to refine the anisotropic displacement parameters. 
 

6. Refinement of anisotropic atomic displacement parameters 

Save the structure as Ni2Si_dyn_ori_anis 
Click the quick button “Edit atoms”; “select all→Define/Edit→ADP parameter(s): harmonic”, 
OK, OK, Yes 
[On the screen: Mains window of Jana2020]. 
Click the quick button” Refine” 
 
Now the refinement converges with R= 7.83%. 
 

Final structure model: 

 


